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This document was provided by Siemens A&D SCE (automation and drive technology, Siemens A&D Cooperates 
with Education) for training purposes.  Siemens does not make any type of guarantee regarding its contents. 
 
The passing on or duplication of this document, including the use and report of its contents, is only permitted 
within public and training facilities. 
 
Exceptions require written permission by Siemens A&D SCE (Mr. Knust:  E-Mail:  
michael.knust@hvr.siemens.de).  Offences are subject to possible payment for damages caused.  All rights are 
reserved for translation and any case of patenting or GM entry.   
 
We thank the company Michael Dziallas Engineering and the instructors of vocational schools as well as further 
persons for the support with the production of the document.   
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1. FORWARD 

 
The module D9 is assigned content wise to Industrial field bus systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Learning goal: 
 
In this module, the reader should learn how the PROFIBUS DP is taken into operation with a SIMATIC 
S7-300 with the communication processor CP 342-5DP as master and the ET 200L as a slave. The 
module shows the principle procedure by means of a short example.   
  
 
Requirements: 
 
For the successful use of this module, the following knowledge is assumed: 
 
• Knowledge in the use of Windows 95/98/2000/ME/NT4.0 
• Basics of PLC- Programming with STEP 7 (e.g. Module A3 - ‘Startup’  
 PLC programming with STEP 7) 
• Basics of the PROFIBUS DP (e.g. Appendix IV – Basics of  

 field bus systems with SIMATIC S7-300) 

Basics of 
STEP 7- Programming 
2 - 3 days     A modules 

Industrial field bus 
systems 

2- 3 days D modules 

Additional functions of 
STEP 7- Programming 
2- 3 days    B modules 

Process 
visualization 

2- 3 days F modules 

Sequencer 
Programming 

2- 3 days C modules 

IT- Communication 
with SIMATIC S7 

1- 2 days E modules 
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Required hardware and software  
 
1 PC, Operating system Windows 95/98/2000/ME/NT4.0 with 

- Minimal: 133MHz and 64MB RAM, approx. 65 MB free hard disk space 
- Optimal: 500MHz and 128MB RAM, approx. 65 MB free hard disk space 

2 Software STEP 7 V 5.x with option NCM S7 PROFIBUS 
3 MPI- Interface for the PC (e.g. PC- Adapter) 
4     PLC SIMATIC S7-300 with the CP 342-5DP  
 Example configuration: 

- Power supply: PS 307 2A 
- CPU: CPU 314IFM 
- PROFIBUS- Communication processor: CP 342-5DP 

5     Distributed I/O ET 200L with 16 digital in- and outputs 
6 PROFIBUS cable with 2 PROFIBUS slots 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1 PC 

 
2 STEP 7 

 
4 SIMATIC S7-300 with  

CP 342-5DP 

3 PC Adapter 

 
5 ET 200L 

6 PROFIBUS cable 
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2. NOTES FOR THE OPERATION OF THE CP 342-5DP 

 
The PROFIBUS communication processor CP 342-5DP makes it possible to attach to it the SIMATIC 
S7-300 by the PROFIBUS with the protocol profile distributed I/O (DP). 
 

The parameterizing of the PROFIBUS parameters for the PLC, such as the configuration of the 

PROFIBUS network, takes place with the software STEP 7. The requirement is the CP342-5DP and 

additionally the software “NCM S7 PROFIBUS “ (Contained already in STEP 7 V5.x!), so that the user 

has a uniform configuration tool for centralized and distributed configuration.  

 
For the SIMATIC S7-300 with the CP342-5 as a Combimaster, the following protocol profiles are at your 
disposal: 
• DP- Interface as master or slave according to EN 50170. PROFIBUS-DP (Distributed I/O) is the 
 protocol profile for the connection of the distributed I/O/field equipment with a quick reaction 
 time. 
• SEND/RECEIVE- Interface (AG/AG) according to the SDA-Service (Layer 2 of the  
 PROFIBUS). SEND/RECEIVE (FDL- Interface) offers functions with which the  
 communication between SIMATIC S5 and S7 are under one another and they can simply and 
 quickly be realized to the PC. 
• S7-Functions. These offer optimal communication in the SIMATIC S7/M7/PC-connection. 
 
On the part of the user program, the transmission of the data range for the DP and FDL communication 
is activated through programmed FC-Block calls and monitoring of effective execution monitored. 
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the function must be copied into the project.  
 
Note:  Here the CP 342-5DP is appointed to the PROFIBUS as a master. 
 

3. NOTES FOR THE OPERATIONS OF THE ET 200L 
 
The ET 200L is a distributed I/O system with a small, compact configuration.  The ET 200L is a passive 
participator (Slave) on the PROFIBUS-DP. 
The PROFIBUS address is adjusted with two rotary switches. 
Another possible adjustment of the PROFIBUS address is with a power recovery.  Therefore, the ET 
200L must be turned off and then back on.  
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4. COMMISSIONING THE PROFIBUS ( MASTER CP 342-5DP / SLAVE ET200L ) 

In the following example, the commissioning of a mono master system with the SIMATIC S7-300 with 

CP 342-5DP as a master and an ET200L as a slave is described. 

For the testing of the configuration, a program will be written in which a display lamp H1 is triggered by 

the simultaneous activation of two buttons S0 and S1.  

Assignment list: 
I 64.0  S0  Button selection 1 on ET200L 
I 64.1  S1  Button selection 2 on ET200L 
Q 64.0  H1  Display lamp on ET200L 
 

1.  The central tool in STEP 7 is the SIMATIC Manager, which is opened here with a double click       

( → SIMATIC Manager). 

 

2.  STEP 7- Programs are administered in projects . Such a project will be created ( → File → New). 
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3.  Give the Name ET200L to the project ( → ET200L → OK). 
 

 
 
4. Highlight your project and insert a PROFIBUS Subnet (→ ET200L → Insert → Subnet → 

PROFIBUS). 
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5. Then insert a SIMATIC 300-Station (→ Insert → Station → SIMATIC 300-Station). 
 

  
 
6.  Open the configuration tool for the Hardware  with a double click (→ Hardware). 
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7.  Open the hardware catalog with a click on the symbol   (→ ). 
There you will see the directories are divided into the following: 
- PROFIBUS-DP, SIMATIC 300, SIMATIC 400 and SIMATIC PC Based Control, 
all module racks, modules and interface modules for the configuration of your hardware configuration 
are made available. 
Insert a Rail with a double click( → SIMATIC 300 → RACK-300 → Rail). 

 

  
 

After the insert, a configurations table for the configuration of the Rack 0 appears automatically. 
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8. Now all modules can be chosen out of the hardware catalog and inserted into the configuration 

table and are also inserted into your rack.  To insert, you must click on the name of the respective 
module, hold the mouse button and Drag & Drop the module into a line of the configurations table.  
We will begin with the power supply PS 307 2A (→ SIMATIC 300 →PS-300 → PS 307 2A). 

 

  
 
Note: If your hardware differs from what is shown above, then you must select the appropriate       
modules from the catalog and insert them into the rack.  The part numbers of the individual modules, 
which are found on the components, are indicated in the footer of the catalog.
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9. In the next step, we drop the CPU 314IFM into the second slot.  This allows for the part number 

and version of the CPU to be read off (→ SIMATIC 300 →  CPU-300 → CPU 314IFM → 6ES7 314-
5AE03-0AB0 → V1.1 ). 
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10. Then we drag the communication processor for the PROFIBUS CP 342-5DP onto the fourth slot. 

Now the order number and version of the model can be read off the front (→ SIMATIC 300 →  CP-
300 → PROFIBUS →  CP 342-5DP → 6GK7 342-5DA01-0XE0 → Product Version 2).  

 
 

 
 
 
Note: Slot number 3 is reserved for interface modules and remains empty. The order number of the 
module is displayed in the footer of the catalog. 
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11.   By the entering of the communication processor, the following window appears, in which you   

 assign a PROFIBUS address to the CPU 342-5DP and must already choose the first PROFIBUS 
 net. When you want to alter the parameter of the PROFIBUS net, you must highlight it and then   
 click on Properties ( → Properties). 

 

  
 
12. Now you can choose the Highest PROFIBUS Address (here → 126), the Transmission Rate 

(here → 1,5 Mbit/s) and the Profile (here → DP). (→ OK). 
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13. Now the addresses of the communication processor in the I/O address space of the CPU are 

noted (Here: PI 256...271 / PQ 256..271).  Choose the properties of the communication process 
through a double click on the ‘CP 342-5DP’ ( → CP 342-5). 

 

  
 
14. Set the Operation Mode  to DP master and accept with OK ( → Operation Mode → DP master 

→ OK). 
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15. Then a bar chart for the Master system is shown to the right of the CP342-5DP, in which you can 

arrange the PROFIBUS slaves. This happens by clicking the desired module  
(here the ET 200L with 16DI/16DO) from the hardware catalog in path PROFIBUS-DP.  By Drag  

 & Drop with the mouse, it can be dropped into the master system (→ PROFIBUS DP  → ET  
 200L → L-16DI/16DO→ 6ES7 133-1BL00-0XB0 ). 
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16. By the entering of the slave, the following window is displayed in which you must assign a 
PROFIBUS address to the slave. This address must be identical to the address that you chose for the 
rotary switch of the ET 200L ( → 3 → OK ). 
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17. The addresses of the in- and outputs on the ET 200L can now be noted  

(Here: I 0...1/Q 0...1).  An automatic address assignment takes place in the order similar to how 
slaves are inputed.    

 
Note:  The declared addresses are the in-/output addresses within the communication processor.  In 
the program of the CPU, one cannot directly access these addresses.  First the in-/output address 
ranges must be transferred over the FC blocks in the address ranges of the CPU.   
 

The configuration table should first be saved and compiled with a click on  and then downloaded in 

to the PLC .  The mode switch of the CPU must be on STOP! ( →  → ) 
 

 
 
18.  The CPU 315-2DP is then activated as a target module of the download activity (→ OK). 
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19.  The station address of the CPU in the MPI net is then chosen.  You are only connected with the 

CPU so you can accept with OK (→ OK). 
 

  
 
20.  From the SIMATIC Manager, open the data block OB1 with a double click ( → OB1). 
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21. Optional:  Enter the properties of the OB1 for documentation and accept with OK ( →OK). 
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The transmission of the data range for the in- and outputs of the PROFIBUS DP slaves is activated 
through the programmed FC block calls of the user program. These FCs also monitor the effective 
execution. 
The block calls for the important communication FC blocks are found in the library  
“SIMATIC_NET_CP“. In order to use these functions, the functions must be copied into the project.  
 
The FC block DP-SEND transfers data from the user program in the CPU to the PROFIBUS- CP.  For 
the operation type of the PROFIBUS– CP, the DP-SEND has the following importance: 
• For the application in DP-Master 

The block assigns the data of the indicated DP output range to the PROFIBUS-CP for the output 
module by the distributed I/O.  

• For the application in DP-Slave 
The block assigns the data of the indicated DP data range of the CPU in the send buffer of the 
PROFIBUS-CP for transmission to the DP-Master. 
By the call of the FC block DP-SEND, the following parameters must be entered: 

 

Name Type Range of values Comment 

CPLADDR WORD  Module-start address (The configuration table can 
be extracted in STEP 7). 

SEND ANY  Indication of the address and length of DP-Send 
range (the address can refer to the I/O-Ranges, bit 
memory address areas and data block areas). 

DONE BOOL 0: - 
1: New data 

Displays, if the job was handled error free. 

ERROR BOOL 0: - 
1: Error 

Error display 

STATUS WORD  Status display 
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The FC-Block DP-RECV receives data over the PROFIBUS DP. For the operation type of the 
PROFIBUS –CP, the DP-SEND has the following importance: 
• For the application in DP- Master 

The block accepts process data of the distributed I/O as status information in the indicated DP input 
range. 

• For the application in DP- Slave 
The block accepts the transferred DP data of the DP- Master from the receive buffer of the 
PROFIBUS -CP in the indicated DP data range of the CPU. 
By the call of the FC block DP-RECV, the following parameters must be entered: 

 

Name Type Range of values Comment 

CPLADDR WORD  Module-start address (The configuration table 
can be extracted in STEP 7). 

RECV ANY  Indication of the address and length of DP-
receive range (the address can refer to the 
I/O-Ranges, bit memory address areas and 
data block areas). 

NDR BOOL 0: - 
1: New data accepted 

The state parameter displays, if new data was 
accepted. 

ERROR BOOL 0: - 
1: Error 

Error display 

STATUS WORD  Status display 

DPSTATUS BYTE  DP-Status display  

 
 
 

 



         Automation– and Drive Technology- SCE 
   

 
T I A  Training document                                                                            Page 23 of 24                                                                         Module D9 
Last revision: 02/2002                                                                                          PROFIBUS-DP with Master CP 342-5DP / Slave ET 200L 

Forward                                     Notes                                     Commission 

 
22. With LAD, STL, FBD: Program blocks, you now have an editor which gives you the possibility to 

generate your STEP 7- Program.  Here the organization block OB1 was already opened with the 
first network.  In order to generate your first logical operation, you must highlight the first network.  
Now you can write your first STEP 7- Program.  Several programs can usually be divided into 

networks.  Open a new network by clicking on the network symbol  . 
 

Here the inputs of the DP slaves are read into network 1 with the block DP_RECV.  You can insert this 
block into your network from the Libraries of blocks in the catalog ( → Libraries → SIMATIC_NET_CP 
→ CP 300 → FC2 DP_RECV). 
 
In Network 3, the outputs of the DP slaves are written with the block DP_SEND. You can insert this 
block into your network from the Libraries of blocks in the catalog ( → Libraries → SIMATIC_NET_CP 
→ CP 300 → FC1 DP_SEND). 
 

Now save the OB1 block  ( → ). 
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Note:  Here an ET200L is integrated with 2 byte input data and 2 byte output data over a  
  CP342-5 DP on slot 5 (Module start address decimal: 256 / Hexadecimal 100).                                        
  The input data should be in the input word IW 64 and the output data should be written to  
 the output word QW64 in the ET200L. 
 

It is important that all data in the defined DP slaves hardware configuration is integrated 
 with block DP_RECV and DP_SEND, whereby all DP slaves are combined in a 
 DP_RECV and DP_SEND. 

The addresses of several modules can be extracted from the hardware configuration.  
 
23. The STEP 7- Program must now be downloaded into the PLC.  In our case, this is done from 

SIMATIC Manager.  There you must highlight the OB1 and the FCs FC1 and FC2 in the folder 

‘Blocks‘ and click on download . The mode switch of the CPU must be on STOP!                  (

→ SIMATIC Manager → Blocks → OB1 → FC1 → FC2 → ). 
 

  
 
24.  Through the switching of the mode switch to RUN, the program is started.  
 
 

 

 


